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RF Explorer is an affordable Handheld Spectrum Analyzer with a growing list of features.
This Little powerful unit is the tool yow needs
to- reduce the implementation time and cost

of your next wireless project.

This Release Notes document is complementary to the RF Explorer for Windows User Manual, available online.
r—
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Please consider the environment before printing this document.
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http://micro.arocholl.com/index.php?option=com_content&view=article&id=61:rf-explorer-windows-pc-client&catid=40:article&Itemid=64

Version 1.11.1307

Release date: CET Jul 24™ 2013

This release includes full support for RF Explorer firmware v1.11, as well as new important
capabilities:

Full compliance with firmware v1.11 — note some features will not be available if you do not
upgrade your firmware to the latest version.

New Device menu with selection of active RF module if a 2-port RF Explorer model is
connected.

Graphic, quality 3D representation of the connected RF Explorer model to better understand
the active RF connector. It also includes an antenna representation but take the antenna
shape as an indication only, the software has no way to know the actual antenna connected,
or if there is an external RF source being used instead of an antenna.

The Spectrum Analyzer screen adds the currently selected Configuration Setting text as part
of the title of the graph. This helps to reference the meaning of the captured signal in a
print or a bitmap file.

Max Hold mode is available now in the View menu, in addition to the pre-existing Max Peak
mode.

The Automatic LCD OFF option has been moved to the new Device menu. This is for
consistency but functionality does not change.

The Spectrum Analyzer includes now timestamp. This feature allows knowing with
millisecond precision the exact time data was captured, so it can be joined with GPS positon
data or other events.

The Remote Screen includes now timestamp. In addition to that, finer control were added to
allow for B/W or color capture, as well as a text header with indication of capture time and
model used on screen for reference.

A more advanced print facility, available from the File menu, allows now to print the Dark
Mode configuration in white background to save toner and make prints easier to read.

The internal Spectrum Analyzer capture buffer is now able to store 10 million sweeps,
thanks to new advanced memory management.

The internal Remote Screen capture buffer is now able to store 64K screens.

The buffer for Spectrum Analyzer and Remote Screen can be independently cleared from the
File menu, Reinitialize Data Buffer command. It will ask for confirmation and will clear the
buffer based on the current screen on focus.

RF Explorer data files include timestamp of each capture, so the persisted data is smarter
and able to display capture time when restored. This include these file formats:

o .RFE —standard RFE data files.

o .RFS —standard RFS screen capture files.

o .CSV — Cumulative CSV files include date and time on each sweep row. Simple CSV
files remain with old format and no timestamp as they are compatible with 3™ party
coordination software tools.

As result of these improvements, the file format is now v002 and therefore not readable
from older versions of the RF Explorer for Windows. However, this new version of the
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software can read older v001 format as well as new v002 format. If you deliver files to other
users, make sure they work with the latest version of the software.

e There are new sample files available in the Examples folder in the RF Explorer installation
program group.

¢ A new Help menu is available at the right of the menu bar. It includes direct access to online
information, manuals and the About box. We are working on a much improved and updated
version of the RF Explorer User Manual so all the information you may need will be just a
click away.

¢ A large number of workflows have been improved and bugs fixed based on user feedback
and reports from different computer configurations. The continuous support of the RF
Explorer community makes all these improvements possible, and we keep investing on
making this software better and more capable based on feedback.

e The underlying software SDK is now revamped in reusable components to make 3™ party
integrations much easier. The foundation of all this functionality is the new
RFECommunicator component, which encapsulates all the complexity of dealing with USB
protocol for you. We will dedicate a full section in the documentation for reference of this
powerful component which makes it possible to create your very own application in a few
minutes, as well as integrate it with pre-existing software tools. As this is a layer on top of
the standard USB communication protocol, you create applications and tools based on the
low level documented protocol or with this new advanced control, your choice, both options
are available. If you are interested on developing software for RF Explorer, place your
questions and comments at www.rf-explorer.com/forum

|
RF Explorer Cumulative Release Notes page 3
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Version 1.09.06

Release date: CET Mar 21%, 2013

This is a bug fixing release. It resolves a problem experienced by some users where the application
will fail to load name settings from disk, and sometimes even crash.

|
RF Explorer Cumulative Release Notes page 4



Version 1.09.05

Release date: CET Dec 14", 2012
This version includes a number of enhancements:

e Internal memory buffer size increased to 30000 samples, previous versions limited it to
10240 samples. Assuming an average of 10 samples/sec, you can get about an hour worth
of data in the memory buffer.

e New Continuous data log feature implemented, it is active by default in menu File->
Continuous Log to RFE data file — \When this new feature is enabled, it will store
information forever as long as there is enough HD space, creating successive .rfe data files
automatically everytime the buffer gets filled and starting all over again.

File | View Default " Lo
| Load RFE data file... @
I Save RFE data As... Mc

L Continuous log to RFE data file |[ [
4 Save RFE data on Close |
Evnnrt Cinale Cianal MO ac 1

e If continuous data log is not active, the application won't store data automatically in files,
but it will keep receiving signal data forever and won't stop when the buffer is full: it will just
clear it and start all over again. Previous versions set the application On Hold and stopped
capturing more data to protect the buffer from being overwritten.

e Signal graph uses smoothed curves (splines) now in the Spectrum Analyzer screen, for a
softer, more pleasant display. The splines have very little tension to avoid any distortion to
the real signal data.

Bug fixes included:

e When connecting a RF Explorer with an old firmware version, it will show now a single
popup with firmware version alert. Previous to this fix, there may be 2 or more popups with
the same information displayed.

e Named Settings file has been moved to a new location, in the AppData global folder where
there is no access right restrictions to store application data. Previous to this fix, Windows
Vista / Win7 and Win8 users with UAC enabled may experience problems storing named
settings. When the new application version is loaded for the first time, it will import old
named settings from the previous location, if it exists. In that way you do not lose the old
settings when upgrading to the new application.

e Named settings work fine now in both scenarios: RF Explorer unit connected and
disconnected. Previous to this fix, certain combination of settings with the unit connected
may not really honor the values on screen and will display bogus frequency information, as
the RF Explorer unit and the Windows software may be not in sync.
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e Performance improved when loading very large .RFE files. Previous to this fix, the tool may
take several minutes to load a RFE file with thousands of samples.

e Reduced verbosity of the report tab window, to keep only meaningful information to the
average user by default. If you need to enable detailed information, check the new Detailed
Debug Info checkbox in the Report tab window anytime. Note detailed information is still
persisted to Report log file, so it is available for client support and detail research in case of
troubleshooting is required.

een | Configuration ‘ Report |

Advanced Remote Command (developer only)
[7] petailed debug info (only if required to diagnose issues)

r

LI
* T Hehel 1

Standard Command |

|
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Version 1.09.04

Release date: CET Oct 10™, 2012
This version includes a number of enhancement and bug fixes:

e There is a powerful facility to persist configuration settings with descriptive names, so they
can easily be restored on demand. You can use this powerful feature to easily setup the RF
Explorer to configurations you commonly use. More information on this feature in the online
manual at www.rf-explorer.com/windows in the “Configuration named settings” section.

e The RF Explorer for Windows now exports a simplified CSV file format as required by IAS
and other Frequency Coordination applications. For more information, please check details
online here. You can also select the CSV delimiter (comma by default, but can be tabulator
and other symbols).

e There are now tooltips to help on understanding what the different functions and commands
are for.

Max Peak START BEEGLD STOP

3l an:
,'[_E]ispla}r Max calculated data based on latest n Iterations F

e The user can now select the default location for data files (auto RFE file, bitmaps, CSV, etc)
in the Configuration tab screen. By default it will go to My Documents\RFExplorer folder.

e A bug that prevented the Peak values on screen to be exported the bitmap or being visible
when the RF Explorer device was on hold has been resolved. This issue was introduced in
previous version v1.09.03.

¢ An internal adjustment on scale is now done automatically when a RFE file is loaded. This
guarantee too low or too high amplitude signals will remain on screen after the file is
loaded.

¢ An optimization on the way the Remote Screen works is now in place, so the Auto LCD OFF
feature disables the Remote Screen controls to make it more obvious to the user the fact
that a remote screen is not available when the RF Explorer device doesn't actually draw
information on screen.
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Version 1.09.03

Release date: CET Aug 10", 2012

This version introduces the first contribution for an external developer; I want to thank Josef Jahn
for implementing this nice first version of a Waterfall display on the RF Explorer Windows Client. If
you have questions, suggestions you can contact him directly or put your question in the forum
www.rf-explorer.com/forum .

Josef developed a functional waterfall tab view and provided the following description:

The waterfall view displays signal intensity across the scanned frequency range over time.
This is different from the normal Spectrum Analyzer graph in that it allows the visualization
of spread spectrum transmissions. Signal intensity is displayed via varying colors: Black and
blue equal low signal strength, yellow and red are used for strong signal levels. The waterfall
display scrolls up, with the latest data displayed at the bottom.

Two sliders for "contrast” and "Intensity” control how the data is displayed. These controls
can be used to adjust the image for optimal visibility of the desired signal. The "intensity”
slider controls the basic sensitivity, it's a constant multiplication factor that is best used to
compensate for environments where the general signal noise level is high. The "contrast”
Slider controls the sensitivity of the waterfall diagram, and is typically used to emphasize low
signal levels. For example, a weak signal can be made more visible by increasing the
contrast.

Manipulating both sliders allows for all kinds of signals to be displayed in the best possible
and most visually apparent way.

The waterfall display uses the maximum received values for the signal intensity. This means
that changing the "Iterations"” value on the "Spectrum Analyzer" tab will affect the data of
the waterfall view. Small values for "Iterations" mean that short signal spikes are displayed
as thin dots or horizontal lines, while larger values cause these lines to expand horizontally.

The frequency range of the waterfall display is identical to the frequency range currently set
on the "Spectrum Analyzer” tab. To examine narrow-band signals in more detail, set the
frequency range accordingly on the Spectrum Analyzer tab - the waterfall view will reflect
these changes.

NOTE: Disable the RF-Explorer's LCD via settings for optimum performance and time
resolution. This is particularly important for examining frequency hopping transmissions.

|
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This is an example of the waterfall view in action: First red bar is a 433Mhz single transmission,

whereas the 5 bars at the bottom are sweep transmissions 1MHz apart.

o
A\ RF Explorer Windows Client | =R i:hl
File  View
Spectrum Analyzer || 'l Materfall ______________ Remote Screen Configuration Report
COM Port Mode Waterfall Controls
.......... C e | 7 i S 1 N
COM3 500000 [ RN | Realtme  gansitivity | 100 U
| Average
Sample: 799 = 5 ' r
Connect Disconnect 4 MaxPesk  Contrast ci5 )
Tterations: 1 = 7] Minimum

(S I

The last waterfall entries correspond to this Spectrum Analyzer view

RF Explorer ON HOLD

Realtime

— Avg Max — Min

T Glint 103 - Fimmwars v01.08 - Modal:433M - Expansion Moduls: WSUB3GIACTIVE) - Active rangs:15-2700MHz -

-20,0
-30,0
-40,0
50,0
-60,0

-70.0

Amplitude {(dBm)

-80.0
-90.0

-100,0

-10,0 | Start: 430,500MHz - Stop:437, 500MHz- Gantar:434,000MHz - Span:7,000MHz - SwespStap:83KHz - REW:B5KHz - Amp Offast:0dBm. . . . . . e L

4310 4320 4330 4340 4350
Frequency (MHZ)

-110,0

4360 437.0

You can get more detailed activity with low Iteration nhumber count in the analyzer view.
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Version 1.09.02

Release date: CET Jul 3rd, 2012

This version introduces the following enhancements:

e Quick toolbar access to a number of advanced functions on the right of the Spectrum Analyzer

screen tab.

-
A RF Explorer Windows Client [E=ESE
File  View
Spectrum Analyzer ‘ Remote Screen | Configuration | Repart |
COM Port. Mode Remote Frequency and Power control
V| Realti
Yo s sor
Sample: 93 =
: s s sroe
Tterations: 10 | [ minimum BOTTON = TOP e
RF Explorer File data M]
= . . ;
. 5
: 2650000MHZ
. | s
E T 3 P
g | | |
@
§ .l
=
: |
00 b e =~
* * i
2449 2450 2451 Bottom +5dB
Frequency (MHZ)
Disconnected File: C:\prog\PICPGM\RFExplorerw1 0\ Docs\Pictures\fe\RFExplorer_Client_Data_2011_10_23_22_02_10.fe "
b - —= r ——— = =

e The configuration tab includes a frequency calibration functionality, see more info on the RF
Explorer firmware v1.09 Beta 05 release notes, as well as this online demo video.

. RF Explorer Windows Client

File  View
Spectrum Analyzer | Remots Screen | Configuration | Report |
COM Port Mode Remote Frequency and Power control

cons 500000 redtime comen IR sean IETEEI | e

D Average .
Sample: 93 =
— P 7] Max Peak sTART ECEENEHS sTOP
. . = . Send
Iterations: JLUN [T Minimum BOTTOM -120 ToP -5 -
Calibration
REFERENCE (MHz)
Calibrate
h —— —_ — — — —
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e Support for the new WSUB3G model, covering frequencies from 15 to 2700MHz. See below an
example of the WSUB3G model capturing commercial FM radio activity (88-108MHz)

A\ RF Explorer Windows Client |

Eile  View
Spectrum Analyzer Remots Screen Configuration Repart
COM Port Mode Remote Frequency and Power control
comMa = N 500000 RUN | HoD | = Z:I:';: CENTER SPAN —
Disconnect Sample: 267 : Max Peak START END —
Tterations: 10 7| Minimum SR m S L

:

Top +5dB

RF Explorer Live data

Top -5dB

[

[

Start < 50%

[

Start < 10%

: RFEXPLORER Firmware v01.09 - Mode!WSUB1G - Expansion Module WSUB3 G(ACTIVE) - Active range:15-2700MHz
 Start: 49,465MHz -End:149,465MHz - Center-99,465MHz - Span:100,000MHz - Step-892 857KHz :

[

Span +25%

[

Span Max

;

Span 10MHz

[

Center Mark

Span Min

[

[

Span -25%

End > 50%

;

[

End » 10%

Battom +5dB

[

3
1]
=3
@
b=
2
=
£
<

[

Bottom -5dB

90,0 100,0 110,0
Frequency (MHZ)

Connected File: none

e Model and mode text is now embedded in the drawing area for easier reading and reference.

-
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Version 1.06.09

Release date: CET Nov 27th, 2011
This version introduces the following enhancements:

e Updated to get benefit of new features available in firmware v1.08 Beta 03. We strongly
suggest upgrading your device.

e New WiFi Analyzer screen. To use it, select WiFi Analyzer in your RF Explorer and a new
graph mode bar will be displayed on the PC screen.

S\ RF Explorer Windows Client |ﬂ|d—hj
Eile  View
Spectrum Analyzer Remote Screen Configuration Report
COM Port Mode Remote Frequency and Power control
com3 = | 500000 RUN iea'ﬁ'“e CENTER SPAN
verage

S Sample: 78 [ —— START 2412800 END | =g i
Tterations: 100 = Py BOTTOM “ TOP E

RF Explorer ON HOLD

Amplitude {dBm)

-110,0

2410,0 2420,0 2430,0 2440,0 2450,0 2460,0 2470,0
Frequency (MHZ)

Connected File: none

e The application will select Max Peak mode automatically when switching to WiFi Analyzer, as
this is the only real useful mode for WiFi analysis.

-
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¢ New option to automatically switch the RF Explorer unit LCD OFF/ON using the new menu
option shown below. This will work with firmware v1.08 beta 03 and newer only.

Eile | Wiew
Load RFE data file...
Save RFE data As...

Export C5Y As...
Save RF5 Screen file As...
Load RFS Screen file As...

Save Remote Image As...

Automatic LCD OFEF

e New Dark Mode skin, some users prefer graphs to be displayed over a black screen to better
simulate a real instrument. You can switch it from normal to dark skin anytime with this
menu option (Dark Color Mode):

View

v | Dark Color mode

« | Display Control Area

e RF Explorer Windows Client GUI now works on Tablet PCs with resolutions as low as
1024x600. This feature was suggested by user Manuel Castro (Thanks!).

f N
. RF Explorer Windows Client | ]
File  View
Spectrum Analyzer Remote Screen Configuration Report

RF Explorer ON HOLD

€
m
=
L]
o
3
£
a
E
<€

2440,0
Frequency (MHZ)

Connected File: none

-
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e To make it easier to display the graph in small screen resolutions, you can now disable the
large control area (also known as ribbon in some applications) using menu option (Display
Control Area):

View

Dark Color mode
[]

Display Control Area

e There is a new Configuration window tab, where you should go when the Control Area has
been disabled and you want to select different configuration options. This screen will be
populated with future configuration options that may not be available in other screens.

F Al
A\ RF Explorer Windows Client @M

File  View

COM Port Mode Remote Frequency and Power control
coM3 = | 500000 giealﬁme CENTER SPAN 50,000 Reset
VErage
sorpr | 4 E| 0% o o
Tterations: | 100 = @] Minimum OTT - TP —an Send
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e The application now can be also resized and maximized on screen to any resolution to make
better use of large screens.

FJ'L\ RF Explorer Windows Client E@u‘
File  View
Spectrum Analyzer | Remote Screen | Configuration | Report |
COM Port Mode Remote Frequency and Power control
. = Average
Terations: | 100 | [7] Minimum BOTTO -0 R o0 en
RF EXPLORER Fi 01.08
RF Explorer ON HOLD Madel: MODEL_th;?)warev
Expansion: MODEL_NONE
[ i Expansion active: False
| Max Min_| Range: 2350-2550MHz
-20,0 T S L I e T T T
300 & PR PN PR b TP -
400 P L . Il
500 T PR Lo T o0-oBu00e o catee st =
m : .
: 4 286MAZ D
T BO0 e 24 25 : : :
@
k= 1
=
—
E_ -70,0
<
-80,0
90,0
-100,0
SI00 e e e e e e e e e e
24200 2430,0 24400 2450,0 2460,0 2470,0
Frequency (MHZ)
Connected File: none
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e The Remote Screen has now additional Zoom values to make better use of larger screens,
and includes a button to save a bitmap directly (same option as using the file menu but
easier to use in a Tablet):

,
S\ RF Explorer Windows Client

=)

Eile  View

Spectrum Analyzer Remote Screen | Configuration | Report |

COM Port

COM3 - 500000

Connect Disconnect

Dump Remote Screen

] Remote Dump active

Sample

4 | Zoom

e There is a feature under development to directly save screen images as video to share, but
it is not finished and the “Save Video...” button will remain disabled in this version.

e The Report window tab has been enhanced with a direct command feature to be used by
developers and advanced users. The list of available commands is that published on the
wiki, and can be pre-selected from a standard command list or sent from a custom
combobox for those commands such as C2-F which need a set of custom values. This list
will grow as we keep adding new features to remote control more functionality, and this
Developer section is what you can use when the Arduino expansion board becomes

available.
r ~
A\ RF Explorer Windows Client l =& éj
Eile  View
Spectrum Analyzer | Remote Screen | Configuration Report |
COM Port Advanced Remote Command (developer only)
COM3 = 500000
Standard Command [LCD OFE 20 V] [ Send ]
I Custom Command L0 -

RF Explorer Cumulative Release Notes

page 16


http://code.google.com/p/rfexplorer/wiki/RFExplorerRS232Interface

Disclaimer

This application is Open Source and available under GPL v3 license by Ariel Rocholl. The source
code is available at http://code.google.com/p/rfexplorer/source/browse and can be modified,
updated and redistributed under GPL license.

For more info on RF Explorer, please visit

www.rf-explorer.com

For instructions to upload this new firmware in your RF Explorer unit, please visit online
documentation at

www.rf-explorer.com/upgrade

Some of these new features documented below may not be available in the user manual until a
final release is published. For questions, please go to RF Explorer forum at

www.rf-explorer.com/forum

You agree that the firmware is provided as-is, without warranty of any kind (either express or
implied). Accordingly, we make no warranties, representations or guarantees, either express or
implied, and disclaims all such warranties, representations or guarantees, including, without
limitation, the implied warranties of merchantability and fitness for any particular purpose, as to: (a)
the functionality or non-infringement of program, any modification, a combined work or an
aggregate work; or (b) the results of any project undertaken using the program, any modification, a
combined work or an aggregate work. In no event shall the contributors be liable for any direct,
indirect, incidental, special, exemplary, consequential or any other damages (including, but not
limited to, procurement of substitute goods or services; loss of use, data, or profits; or business
interruption) however caused and on any theory of liability, whether in contract, strict liability, or
tort (including negligence or otherwise) arising in any way out of the use of the program, even if
advised of the possibility of such damages. You hereby waive any claims for damages of any kind
against contributors which may result from your use of the firmware.

|
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